
ORMCP Technical Paper 13 – Subwatersheds – Impervious Surfaces 
 

1 

 

1 Purpose and Overview 

This technical paper provides guidance to municipalities, landowners, developers and 
their consultants in planning, developing and implementing the provisions of Section 27 
of the Oak Ridges Moraine Conservation Plan (ORMCP). 

2 Related Considerations 

When preparing Subwatershed Evaluations, it is suggested that the reader also review 
the highlighted, associated topic areas as discussed in the ORMCP, as shown in 
Figure 1 below. 

Clean Water Act, 2006 
The Clean Water Act, 2006 was passed on October 19, 2006. Associated regulations, 
Director’s Rules and technical modules are currently being developed. Readers of this 
technical paper should take note that the requirements of the Clean Water Act, 2006 
may have implications to initiatives undertaken to implement the ORMCP. Information 
concerning the Clean Water Act, 2006 is available at: www.ene.gov.on.ca/en/water/.  

Further Reading 
Please also refer to the additional list of resources and references listed at the end of 
this technical paper. 
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27.   

Figure 1 ORMCP Topic areas and Linkages with Technical Paper 13 - Subwatersheds - Impervious 
Surfaces 

3 Watershed Plan Requirements of the Oak Ridges Moraine Conservation Plan 

The ORMCP requirements pertaining to watershed plans are as follows: 

(1) Except with respect to land in Settlement Areas, all development and site 
alteration with respect to land in a subwatershed are prohibited if they would 
cause the total percentage of the area of the subwatershed that has impervious 
surfaces to exceed;  
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a) 10 per cent; or 
b) any lower percentage specified in the applicable watershed plan.  

(2) Except with respect to land in Settlement Areas, in considering applications for 
development or site alteration with respect to land in a subwatershed the 
approval authority shall take into account the desirability of ensuring that at least 
30 per cent of the area of the subwatershed has self-sustaining vegetation. 

(3) With respect to land in Settlement Areas, in considering applications for 
development or site alteration with respect to land in a subwatershed the 
approval authority shall consider the importance of, 
a) ensuring that natural vegetation is maintained, and where possible improved 

or restored; and 
b) keeping to a minimum impervious surfaces and their impact on water quality 

and quantity. 

4 Rationale for the Requirements 

The ORMCP defines impervious surface as a surface that does not permit the 
infiltration of water, such as a rooftop, sidewalk, paved roadway, driveway or parking 
lot. Urban landscapes are typically characterized by large areas of impervious surfaces 
and proportionately low levels of vegetative cover. Impervious surfaces decrease the 
amount of water that infiltrates into the ground, increase the volumes of stormwater 
runoff, and speed the delivery of runoff to streams or other receptors, resulting in a 
variety of environmental impacts (Figure 2). Groundwater levels and stream base-flows 
decline, whereas the magnitude of storm flows and the frequency of bank-full flows 
increase. These alterations to stream hydrology accelerate erosion, resulting in stream 
channel instability, and modification of the physical habitat of streams. Increased runoff 
and reduced stream base-flows alter stream water temperature regimes. Impervious 
surfaces accumulate pollutants, such as lawn fertilizers, residues from tires, and road 
salt, which are collected and transported by storm runoff, impacting the quality of water 
and sediments. Mechanisms to reduce salt loading from winter maintenance of roads 
and parking lots may be required to address water quality concerns with respect to 
infiltration of stormwater. 
Cumulatively, these changes in hydrology, stream form, temperature regime, and 
water and sediment quality adversely impact biological communities. These changes 
may, for example, contribute to the local extinctions of sensitive species of fish and 
aquatic invertebrates from the community. Stormwater management facilities are 
expected to be able to reduce, but not eliminate, these impacts. For example, although 
it may be theoretically possible to maintain pre-development groundwater recharge 
rates using stormwater infiltration techniques, it may be impossible to match 
simultaneously pre-development to post-development water balances for both the 
groundwater and surface water flow systems. 
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Figure 2 Diagram of pathways by which impervious surfaces may impact aquatic biological 
communities 
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Impervious Surfaces

Because imperviousness is a direct result of urbanization, it has been proposed as a 
unifying theme and a general environmental indicator of change due to urban growth 
with implications to watershed management. Specifically, setting limits on the 
percentage of impervious land cover permitted within watersheds has been suggested 
as a potential approach to manage the effects of land development on streams in 
sensitive areas and to prevent cumulative impacts at the subwatershed scale. 
Imperviousness is one of the few variables that can be explicitly quantified, managed, 
and controlled at each stage of land development. 
Placing a lower limit on areas of self-sustaining vegetation and an upper limit on 
subwatershed imperviousness are valuable conservation measures for protecting 
streams. There are numerous studies that demonstrate a correlation between the 
degree of subwatershed urbanization, as indexed by imperviousness, and the 
ecological condition (health) of a stream. This relationship is especially strong at the 
subwatershed scale for small (stream orders 1 to 3), headwater streams. The precise 
thresholds of self-sustaining vegetation and impervious cover necessary to conserve 
streams regimes are not known with certainty; however, there is a growing consensus 
in the literature (see Appendix A) that impairment of stream ecosystems occurs at 
approximately 10% imperviousness. The few studies available for watersheds of the 
Greater Toronto Area confirm that deterioration in the biological integrity of streams is 
associated with relatively low levels of watershed urbanization. The 10% threshold for 
impervious surfaces in the ORMCP is provided as an upper limit to be confirmed, or 
lowered if necessary, based on the findings of watershed plans. 
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5 Implementation of the Requirements 

5.1 Linkages to other Activities 

Figure 1 shows links between subwatershed imperviousness and other ORMCP 
topic areas. 
The preparation of a watershed plan provides an opportunity to determine the 
present and projected future levels of imperviousness and self-sustaining 
vegetation within subwatersheds. The watershed plan may specify a target for 
impervious surfaces of lower than 10% within one or more subwatersheds. 
Section 45 of the ORMCP requires that an application for major development be 
accompanied by a stormwater management plan. The stormwater management 
plan provides a useful context within which to consider the impervious surfaces 
associated with a proposed major development and techniques to minimize their 
impacts to water quality and quantity.   
The review by the approval authority of applications for development or site 
alteration provides an opportunity to evaluate the implications of proposed 
development or site alteration with respect to the subwatershed limits to 
impervious surfaces and to set conditions for development approval that: 

• minimize areas with impervious surfaces; 

• increase areas retained in a natural undisturbed state; and 

• minimize the impacts of impervious surfaces on water quality and quantity. 

5.2 Determining the Present Imperviousness of a Subwatershed 

The ORMCP defines a subwatershed as an area that is drained by a tributary or 
some defined portion of a stream. Subwatersheds will normally be defined 
through a watershed plan. The watershed plan technical paper recommends 
minimum study area units for preparing watershed plans within the Oak Ridges 
Moraine. Once a subwatershed’s boundaries are established, the total area of 
the subwatershed and the component areas comprising impervious surfaces 
can be determined. 
For the purposes of calculating the impervious fraction of a subwatershed, 
Settlement Areas and lands located outside of the Oak Ridges Moraine 
boundary may be excluded from the total area of the subwatershed (see Table 
1). Nevertheless, with respect to Settlement Areas, Subsection 27(3) of the 
ORMCP encourages approval authorities to consider maintaining, improving or 
restoring natural vegetation, as well as minimizing impervious surfaces and their 
impacts on water quality and quantity. In addition, municipalities are encouraged 
to adopt a comprehensive approach to the maintenance of self-sustaining 
vegetation and the management of impervious surfaces throughout entire 
subwatersheds. 



ORMCP Technical Paper 13 – Subwatersheds – Impervious Surfaces 
 

6 

 

Table 1 Implementing subwatershed limits to impervious surfaces 

Scenario Implementing Limits to Impervious Surfaces 
1. The 

subwatershed is 
located entirely 
within the 
ORMCP Area. 

(a) No lands in the 
subwatershed are 
designated as Settlement 
Areas. 

No development or site alteration if impervious 
surfaces in the subwatershed exceed 10%, or 
lower percentage specified in the applicable 
watershed plan. 

(b) All lands in the 
subwatershed are 
designated as Settlement 
Areas. 

Impervious surfaces and their impacts to water 
quality and quantity are to be minimized. 

(c) The subwatershed 
contains both lands 
designated as Settlement 
Areas as well as lands in 
other ORMCP 
designations. 

Outside of Settlement Areas, no development 
or site alteration if impervious surfaces 
calculated on the basis of the non-Settlement 
portion of the subwatershed exceed 10%, or 
lower percentage specified in the applicable 
watershed plan. 
 
Within Settlement Areas, impervious surfaces 
and their impacts to water quality and quantity 
are to be minimized. 

2. The subwatershed includes lands within the 
ORMCP Area as well as lands outside of the 
ORMCP Area. 

Compliance with the impervious surface limits 
to be calculated based solely on that portion of 
the subwatershed located within the ORMCP 
Area. Within the ORMCP Area, limits to be 
implemented as outlined in 1) above. 

There are various methods for determining the existing amounts of impervious 
surfaces. At the site level, direct on-the-ground surveys and measurements can 
be made. In many cases, it may be possible to digitize or estimate impervious 
areas from subdivision plans, stormwater management plans, or engineering 
plans on file. Field surveys or aerial photographs could be used to confirm the 
currency of estimates derived in this manner. 
Over broader areas, a Geographical Information System (GIS) can be used in 
conjunction with digital ortho-rectified aerial photographs for:  

• random sampling  

• digitizing, or  

• land classification analysis.  
Random Sampling is a GIS tool in which random points are generated across 
an image and identified as impervious or non-impervious surfaces. Provided 
that a sufficient density of randomly-selected points is sampled, the percent 
imperviousness can be estimated as the proportion of sampled points that fall 
on impervious areas.  
Digitizing is an on-screen method to create polygons which outline impervious 
areas. Once the total impervious area is calculated, it is divided by the total area 
of the subwatershed to determine the impervious cover fraction.  
Land Classification is conducted in Image Processing Software, which classifies 
an image based on categories of pixel values.  
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Table 2 provides a summary comparison of these three GIS methods. User-
friendly guides to each of the methods are provided in Appendix B. The method 
or combination of methods to be used should be selected on a case-by-case 
basis. For example, random sampling could be used as a quick method for 
initial screening purposes, whereas a more-detailed digitizing could be used in 
situations where greater accuracy is required, for example, to verify information 
on a site-by-site basis or to resolve disputes in subwatersheds approaching the 
10% imperviousness threshold. Whichever method is used, input from 
stakeholders or local planners may be of assistance in identifying discrepancies 
between the ground and maps, if the air photo coverage is incomplete or not 
current. 
The ORMCP limits on percent imperviousness are intended to apply to the total 
imperviousness of a subwatershed, excluding Settlement Areas and lands 
located outside of the Oak Ridges Moraine Boundary. Therefore, for the 
purpose of evaluating compliance with the 10% limit, no distinction should be 
made between those impervious surfaces, such as urban roads, that are 
connected directly to a stormwater conveyance and those impervious surfaces, 
such as roofs, that may direct runoff to pervious areas such as yards. 
Once the present level of subwatershed imperviousness is known, it will be 
important to update the information by monitoring changes to imperviousness 
due to land development. Depending on the extent of new development and site 
alteration in a subwatershed, it may also be necessary to revisit the estimates 
periodically, for instance, when new air photo coverage becomes available for 
the subject area.  
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Table 2 Summary and comparison of GIS methods for estimating subwatershed imperviousness 

  
 Method

Random Sampling Digitizing  Land Classification 
Labour Time 
Required 

Minimal, under two 
hours for most 
subwatersheds. 

Heavy labour time 
requirements, up to 8 
hours or more for larger 
subwatersheds. 

Intermediate, 2 to 4 hours 
required for performing pre and 
post classification prep and 
analysis, yet little labour 
required during actual running 
of analysis. 

Processing 
Time 
Required 

Minimal, not a limiting 
factor. 

Minimal, not a limiting 
factor. 

Heavy demands upon 
computer resource, leading to 
potentially several hours of 
processing. 

Computer 
Resources 
Required 

Standard Desktop PC. Standard Desktop PC. Fast Desktop PC or 
workstation. 

Accuracy Least accurate of three 
methods, depends a 
great deal on user 
interpretation. Least 
consistent method. 

Potentially very accurate, 
if analyst takes proper care 
and is skilled in air photo 
interpretation. 

No possibility of analyst 
misinterpretation, however, 
accuracy can vary due to 
computer misclassification of 
some pixels. 

User GIS 
Skills 
Required 

Beginner GIS skills 
required only. 

Intermediate GIS skills 
required, including ability to 
install and run AML scripts. 
As well, air-photo 
experience is necessary. 

Advanced GIS and image 
processing knowledge required, 
and a high degree of technical 
skills. 

User 
Friendliness 

Easiest and least 
demanding method, not 
technically challenging. 

Can be tedious as it 
demands a high level of 
user attention to detail. 

Actual analysis requires little 
user input, however, image 
processing software is 
complex and has a high 
learning curve. 

Computer 
Software 
Required 

ArcView GIS or 
equivalent, with ability to 
display digital ortho-
photos. 

ArcView, ArcGIS or 
equivalent, with ability to 
display digital ortho-
photos. 

ArcView/ArcGIS and image 
processing software such as 
Erdas Imagine or PCI 
Geomatica. 

5.3 Determining the Future Imperviousness of a Subwatershed 

For future development, estimates of impervious areas can be obtained from 
subdivision plans or site plans, for either new proposals or plans approved but 
not yet built. In fact, estimates of imperviousness may already be provided with 
submissions as part of stormwater management plans or land budgets. In 
addition, the potential that there may be future development on existing lots 
should be considered. Note that some future development may be exempted 
from the ORMCP’s requirements through the transition provisions in both the 
ORMCP and the Oak Ridges Moraine Conservation Act, 2001. The impervious 
surfaces from these developments should be counted as contributing to 
imperviousness of the subwatershed but, because of the exemptions provided, 
the impervious surfaces of these developments will not be subject to the 
subwatershed limits. Similarly, the construction of facilities for transportation, 
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infrastructure, and utilities uses as described in ORMCP Section 41, by a public 
body, is excluded from the ORMCP definitions of “development” and “site 
alteration” and is therefore exempted from the subwatershed limits to 
impervious surfaces. Although these facilities are exempt from the limits, the 
impervious surfaces of these facilities should still be counted as contributing to 
the impervious surfaces of the subwatershed.    
If future impervious cover is not known, it can be estimated by the following 
methodology: 
1. Identify undeveloped parcels by their land-use designation and zoning 

category in each subwatershed. 
2. Subtract unbuildable land (e.g. Natural Core Areas, floodplains, steep 

slopes, conservation lands, etc.) from the parcel land. 
3. Multiply each undeveloped parcel by an average impervious cover for the 

associated zoning category. The impervious cover fractions associated 
with various forms of existing development can be analyzed and used, in 
conjunction with municipal building standards, as a basis to estimate the 
future impervious cover fractions for various zoning categories. 

4. Calculate the area of planned highways and arterial roads and add this 
number to the sum of the impervious area for all land uses in the 
subwatershed. 

5. Add new impervious area to current impervious area to yield the total 
future impervious area. 

6. Divide the total future impervious area by the total area of the 
subwatershed to get an impervious cover fraction, and multiply by 100 to 
express as an impervious percentage. 

5.4 Implementing the Subwatershed Limits to Impervious Surfaces 

Table 1 provides guidance on implementing the subwatershed limits to 
impervious surfaces. 
At first glance, limiting impervious surfaces may appear to encourage 
development on large lots throughout a subwatershed. However, this is not the 
intent of the ORMCP, nor is it the best way to comply with the limits on 
impervious surfaces. The intent of the ORMCP is to direct and concentrate 
development into the Settlement Areas and away from the Natural Core, Natural 
Linkage, and Countryside areas. Because transportation-related 
imperviousness – roads, parking lots, driveways, and sidewalks – is in most 
cases the predominant source of imperviousness, clustered development is one 
of the most effective ways to reduce imperviousness. It is envisioned that the 
watershed plans required by the ORMCP will provide the opportunity to assess 
the current and projected future levels of imperviousness within subwatersheds 
and provide decision-makers with an estimate of how much additional 
development, if any, can be accommodated and where within the watershed it 
would be best located. Applications for new development or site alteration can 
be evaluated based on the implications of the additional imperviousness with 
respect to the 10% imperviousness limit within a subwatershed, or a lower 
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percentage limit specified in the applicable watershed plan. Approval authorities 
may choose to make available upon request information about the current and 
committed level of impervious surfaces within a subwatershed so that 
prospective developers can obtain this information at an early stage.  
The Provincial Policy Statement (2005) under the Planning Act also provides 
planning guidance related to development in “countryside areas”.  Section 
2.3.4.3 states that “the creation of new lots in prime agricultural areas shall not 
be permitted, except in accordance with policy 2.3.4.1(c)” and section 2.3.5.1 
specifies types of land uses that may, in certain circumstances, be permitted in 
prime agricultural areas.  
When preparing subwatershed evaluations, it is suggested that the reader also 
refer to the Greater Toronto Area Agricultural Action Plan for insights into the 
interface between urban and agricultural land uses. The reader could also refer 
to documents relating to stormwater from the Toronto and Region Conservation 
Authority and other conservation authorities in the Oak Ridges Moraine. 

5.5 Reducing Site-scale Imperviousness and its Impacts 

For areas of existing or proposed new development such as in Settlement 
Areas, there are a number of techniques that can be used to decrease the 
extent of impervious surfaces or reduce their impacts. Creating pervious 
surfaces encourages water infiltration and minimizes the risk of flood and 
stormwater runoff containing harmful contaminants from reaching streams, 
rivers, and lakes and degrading water quality. 
Options for reducing imperviousness at the site scale include clustered 
development, reducing or redesigning parking areas and using a hierarchy of 
street widths that allow for reduced widths for residential roads rather than 
uniform standards. 
The impacts of impervious surfaces may be reduced by using best management 
practices, such as using porous pavement and employing techniques to reduce 
the direct connection of impervious surfaces to watercourses and thereby 
encouraging water to infiltrate at the lot-level or in stormwater conveyances. For 
instance, roads with grassed ditches are preferred over a curb-and-gutter 
design in this regard.  
The Ministry of the Environment’s Stormwater Management Planning and 
Design Manual provides a comprehensive guide to best management practices 
for stormwater. The ORMCP Technical Paper 9 – Watershed Plans, provides 
additional information. The Center for Watershed Protection (www.cwp.org) has 
useful information regarding impervious cover, stormwater management, and 
site design.  

5.6 Subwatersheds that already exceed the 10% threshold 

In some cases, the initial assessment of subwatershed imperviousness may 
reveal that the proportion of impervious surfaces in the subwatershed is already 
beyond the 10% limit, or that future committed development that was approved 
prior to the promulgation of the ORMCP will increase imperviousness to over 
10%. In these situations, no increase in imperviousness should be permitted in 
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those parts of the subwatershed designated as Natural Core, Natural Linkage or 
Countryside. As per Subsection 27(3) of the ORMCP, within Settlement Areas, 
consideration should be given to maintaining, improving or restoring natural 
vegetation and minimizing impervious surfaces and their impact on water quality 
and quantity. Again, watershed plans provide a context in which to consider 
these specific situations in detail. 

5.7 Monitoring  

Figure 3 shows a suggested hierarchy of monitoring related to the water 
provisions of the ORMCP. The scope of monitoring will vary for each program or 
project based on the requirements of the ORMCP, environmental targets 
identified in a plan, and specific conditions of an approval.  
It is suggested that details of the monitoring to be undertaken, such as the 
frequency at which samples will be collected or observations made, the 
locations to be monitored, the methods to be used, and the duration of 
monitoring be designed to suit the specific needs of the particular program or 
project.  
The Ontario government, in consultation with municipalities, shall over time 
identify performance indicators for monitoring the effectiveness of the ORMCP 
(see the Implementation section of the ORMCP). The Province, in partnership 
with appropriate stakeholders, shall establish a monitoring network to collect, 
summarize, and evaluate performance indicator data to: 

• assess changes in the ecological integrity of the Moraine; 

• assess the effectiveness of the policies of the Plan in achieving the Plan’s 
vision and objectives; 

• help identify improvements that would address problems encountered in 
implementing the Plan. 

In addition to satisfying the needs of local watershed plans or specific projects, 
monitoring at the other scales (i.e. at the site, site vicinity, and watershed 
scales) may provide valuable information that will contribute to the overall 
monitoring of the ORMCP. 
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Figure 3 Hierarchy of monitoring related to the water provisions of the ORMCP 

 
With respect to impervious surfaces, monitoring by the municipal approval 
authority is suggested: 

• to track the percentages of impervious surfaces within subwatersheds to 
ensure that they do not exceed the 10% limit specified in the ORMCP (or 
lower percentage specified in the applicable watershed plan); 

• to track the percentages of self-sustaining vegetation in subwatersheds to 
assess accordance with the target of 30% specified in the ORMCP. 

To ensure that applications for development or site alteration outside of 
Settlement Areas are in accordance with the ORMCP, the municipal approval 
authority will need to evaluate whether a proposed development or site 
alteration can proceed without causing the subwatershed impervious surfaces to 
exceed the limit. Therefore, it is suggested that municipal approval authorities 
keep up-to-date estimates of the percentages of impervious surfaces within 
subwatersheds as described in this technical paper.  
Upper-tier and single-tier municipalities may choose to integrate the tracking of 
impervious surfaces and self-sustaining vegetation into Watershed Plan 
monitoring, to quantify and explore relationships between the extent of land 
development and indicators of ecological integrity. 
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Appendix A 

Imperviousness: Jurisdictional Scan 

Research conducted over the past 15 years in various geographic locations has resulted in 
the similar conclusion that stream degradation occurs at relatively low levels of subwatershed 
imperviousness (6).  For example, a study of 47 small watersheds in southern Wisconsin 
found that imperviousness between 8-12% resulted in a major drop in the number of fish 
species and base flow (11). A study in Washington, D.C. determined that the diversity of 
benthic macroinvertebrates was good to fair when imperviousness was less than 10% but 
diversity became poor when imperviousness exceeded 12% (7).  A similar study in Delaware 
found that aquatic insect diversity fell into the poor category at levels of 8-15% 
imperviousness (8).  A study of Greater Toronto Area streams used a measure of urban land 
use (both pervious and impervious urban areas) to determine that fish diversity changed from 
fair to poor when urban land constituted approximately 35% of a watershed (9).  Other 
authors estimated that this value of urban land use corresponds to approximately 7-10% 
imperviousness (2).  Studies in the Pacific Northwest (U.S.) reported deterioration in the 
physical and biological condition of streams and wetlands almost immediately in the 
urbanization process as total impervious area increased to 5-8% (2, 3).  A study of four 
headwater streams in Maryland found an inverse relationship between subwatershed 
imperviousness and the total numbers of fish species and sensitive species.  At 55% 
imperviousness, no sensitive fish species remained (7).  In another Maryland study, a variety 
of hydrological, water quality, and biological information was used to conclude that serious 
impairment could be prevented if watershed imperviousness does not exceed 15%, or 10% 
for more sensitive ecosystems with self-sustaining trout populations (4). 
A decision-making framework for streams in Melbourne, Australia uses an imperviousness threshold 
of 12% (10). Researchers from the Center for Watershed Protection in Maryland proposed an urban 
stream classification model based on a series of individual indicators of stream quality.  The model 
proposes a threshold of 10% watershed impervious cover at which sensitive stream elements are lost 
and a second threshold around 25% to 30% impervious cover where most indicators of stream quality 
consistently shift to a poor condition (1).  An adaptation of this model is shown in Figure A.1. 
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Figure A.1 Graph depicting stylized relationship of imperviousness to stream health (Modified from 
Arnold and Gibbons, 1996) 
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There are regulations governing impervious cover in a number of jurisdictions in the United 
States (1). For example, in Maryland, a limit of 10% imperviousness is applied to designated 
Special Protection Areas (5). Ordinances limiting impervious cover have also been 
established in Austin and San Antonia, Texas because of concerns about the quality of the 
area’s major drinking water supply aquifer, as well as in some communities in Florida.  A limit 
of 5% imperviousness applies to a small residential area adjacent to a coastal shellfish 
protection zone in Maine. The City of Olympia in Washington has a comprehensive program 
to reduce impervious surfaces (1). 
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Appendix B GIS methods for estimating subwatershed imperviousness 
Random sampling method in Arc-View 
1) 	Required Data 

To begin, the user will require the following files: 

• Geo-referenced Ortho-photos covering the selected region of study 

• GIS boundary file (polygon) for the region of study (sub-watershed) 

Impervious surfaces to be considered include: 

• Houses, buildings, factories & all structures. 

• Pools, arenas, tennis courts. 

• Paved roads, driveways, parking lots. 

• Any other human-made objects that are permanent that does not allow water to penetrate into the ground. 

To generate random samples, an Arc-View extension will need to be added to Arc-view. 

2) 	 What is a random sample? 

Random Sample generates a specified number of randomly placed points within a polygon. These points are 
then added to the view as another theme. These randomly placed points can then be used to analyze the 
accuracy of a digitized image or land classification. In the case of this project they are being used to determine a 
percentage of impermeable land in the study areas. 

i. 	 To download the Arc-View extension, download the file (simplers.avx) located on the CD-Rom in a folder 
named "Scripts & Extensions" into the EXT32 directory. By default, this is at 
C:/esri/av_gis30/arcview/ext32. 

ii. 	 It will then appear in the extension list (found in the Project ® Extensions menu) as "Simple random 
sampling". Select this extension. (See Figures B 1 & B 2) 

iii. 	 Open the “Theme” menu and select the “Sample..” option. The random sampler dialog box will then 
appear 

iv. 	 Within the dialog box, choose the sampling strategy as “by number”. (See Figure B 3). Click “Ok”. 

v. 	 Then the sampling utility will prompt you for the number of random points to be generated. Enter “100”. 
Click “Ok”. (see Figure B 4) 

Note: The value of 100 points has been suggested based on the general practices used by image analysis 
professionals. For every class of landscape feature, a minimum of 50 sample points is suggested in order to 
create a representative sample. Since this study uses two classes (impervious and non-impervious), a minimum 
of 100 points is required. 
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Figure B 1 Select Extensions  Figure B 2 Select Simple Random Sampling 

Figure B 3 Select by Number 

Figure B 4 Enter 100 

vi. 	 The user will then specify the filename and location to save the random sample points theme. Once 
saved, ArcView will automatically add the points theme to the View. To observe a study area with 
random sample points see Figure B 7. 
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What does this specific extension do? 

Simple Random Sample computes random sets of points within polygons in two ways. It can (1) choose points 
independently and uniformly within the selected features of a theme or (2) choose points independently within 
features with a sampling intensity proportional to feature area.  In the first mode, "by number", you are creating a 
simple random sample of the union of all selected features.  It is the nature of randomness that some of the 
features may receive no samples while others may receive far more than their "fair share."  In the second mode, 
"by intensity", you can guarantee that each feature has approximately the "right" number of samples.  (The 
sample points will look like a dot density map for the feature areas.) 

The output is in the form of a point shapefile.  The output points receive sequential identifiers only.  

3) Estimating Percentage Impervious Surfaces using Randomly Generated Points 

i. Select the random points theme in the View, making it active. 

ii.  Open the Attribute Table for this layer. Select “Theme ® Table”. The attribute table will now be 
displayed. 

iii. A new column will need to be added to the attribute table. This can be accomplished by selecting the 
“Table” menu and choosing “Start Editing”. 

iv. Access the “Edit” menu and choose “Add Field”. The “Field Definition” dialog box will appear. 

v. In the “Name” field enter “Permeable?” 

In the “Type” field select “String” 

In the “Width” field enter “3” 

Click “Ok”  (see Figure B 5) 

Figure B 5 Field Definition 

vi. Re-open the attribute table. A new column named “Permeable?” will have appeared 

vii. The next step is then to define each of the points. They have to be defined as permeable (Y) or not 
permeable (N). To do this each point will have to be examined visually with an ortho photo background. 
Zoom in on the point until you can discern if the area where the point lies is permeable or not. For 
examples refer to Figures B 8 and B 9. If a point lies on a permeable surface, enter “Y” in the attribute 
table in the appropriate row. If the random point lies on an impermeable surface, enter “N” in the 
attribute table record for that point. (see Figure B 6) 

viii. Once the visual examinations are complete, the calculation of the percentage of impermeable land can 
be accomplished. First you must stop editing and save the edits (“Table → Stop Editing”). 

ix.  The total number of “N” observations needs to be tallied. The “Permeable?” column can be sorted once 
it has been selected in the attribute table viewer. Then the sorting process can be initiated using the 

“Sort Ascend” icon. 
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x. 	 Once the sorting process has been completed, manually select all the “N” records in the table. The 
number of total selected records will be displayed by ArcView under the icon bar at the upper left corner 

of the screen. 

xi. 	 The final step is to divide the number of selected (“N”-“Permeable?”) by the total points (100). This 
results in the percentage of impermeable land in the study area based on random samples. 

Note: The last number in the attribute table is “99”. This is because the table has a “0” as a record, which results 
in the total of 100 records (points). 

Figure B 6 Attributes of random points 

Figure B 7 Random sample points for a subwatershed polygon 
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Figure B 8 Road 

Figure B 9 Tennis Court 
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Digitizing method in Arc-View 
1) Required Data 

To begin, the user will require the following files: 

i. Geo-referenced ortho-photos covering the selected region of study; 

ii. GIS Road network file; and 

iii. GIS boundary file (polygon) for the region of study. 

Impervious surfaces to be digitized include: 

•	 Houses, buildings, factories & all structures; 

•	 Pools, arenas, tennis courts; 

•	 Paved roads, driveways, parking lots; and 

•	 Any other human-made objects that are permanent that does not allow water to penetrate into the 
ground. 

2) Preparing Road Dataset for Analysis 

Most municipal users will have a GIS road network dataset, which already conforms to the boundaries of their 
study area. If this is the case, please move forward to Section #3. 

For those users that will need a subset of the road dataset which conforms to their study area, a clip procedure 
will need to be employed in ArcView. 

(a) Procedure for Clipping in ArcView GIS 

i. 	 Ensure that both datasets (roads network and study area boundary file) are displayed in the current 
view; 

ii. 	Activate the Geoprocessing Extension. This can be accomplished by clicking: 
File → Extensions → Check the “Geoprocessing” option → Select “Ok”; 

iii. Click 	 the “View” menu and select “Geoprocessing Wizard”. 

iv.	 In the Geoprocessing Wizard dialog box, select “Clip one theme based on another” and select 

“Next” (see Figure B 10); 


v.	 “Select input theme to clip”: Select the road network file (see Figure B 11); 

vi.	 “Select a polygon overlay theme”: Select the study area boundary file; 

vii. 	 “Specify the output file”: Choose the name and location to save the output shapefile. Select 

“Finish”. 


viii. 	 The Clip operation will then run. Upon completion, the new clipped road file will be added as a new 
theme to the View. 
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Figure B 10 Clip one theme based on another 

Figure B 11 Select input theme to clip, polygon overlay theme, and specify output file 
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3) Digitizing 	 Roads 

While roads may be digitized manually, a time and labour-saving technique involves using the GIS road network 
file for the region of study. Although the road data is often a line file, GIS “buffering” can be used to transform 
this line data into a polygon.  

Note: If the user has a double line/polygonal road file, the buffering step is not necessary and the user can 
proceed to Step #4. 

A buffer is a “zone of specified distance around features1”; creating a new polygon around a feature (in this case, 
the road network dataset).  

Before starting the ‘Buffering’ procedure, the user must decide the average width of the roads in their study area.  

Note: A standard two-lane road with sidewalks is approximately 11 metres.  If unknown, users can determine 
road width from their Ortho-photo images using the ArcView measurement tool. 

i. 	Click “Theme” → “Create Buffers. Note: If the Create Buffers menu choice is disabled, the view’s 
map and distance units will need to be set. (View → Properties → Select “metres” for Map Units and 
Distance Units → Ok; 

ii. 	 In the “Create Buffers” Dialog Box, select “The Feature of a Theme” and then choose the road 
network file which conforms to the study area boundaries (the file clipped by the user in Step #2). 
Click “Next”. (see Figure B 12); 

iii. 	 Select “At a specified distance”. Enter the desired buffer width. (see Figure B 13) Click “Next”; 

iv. 	 When prompted to “Dissolve barriers between buffers?”, select “Yes”. Then in the “Create Buffers 
So They Are” submenu, choose “inside and outside polygons”. Finally, choose to save the buffer “in 
a new theme” in any location. Click “Finish.” (see Figure B 14). 

Note: The value entered in the buffer dialog box will be half of the desired average road width. Example: To 
attain a buffered road of 11 m width, enter 5.5 m in the dialog box. 

Figure B 12 Buffer the features of a theme 
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Figure B 13 Create buffers at a specified distance 

Figure B 14 Create buffers at a specified distance 
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4) 	 Digitizing Other Impervious Surfaces from the Ortho-photo Images 

While digitizing the roads network can be accomplished automatically using buffering, digitizing other features 
can only be performed manually. This requires editing the buffered roads file.  

i. 	 The buffered roads file must be made editable by first activating the roads layer. Then click the 
“Theme” menu and select “Start Editing”. This will create a dotted box around the theme, indicating it 
is ready to be edited. (see Figure B 15); 

Figure B 15 Start editing the theme 

ii. 	 Select the “Draw Polygon” tool (see Figure B 16). Then begin digitizing impervious surfaces by 
tracing around their extent on the ortho-photo image.  

Figure B 16 Select the "Draw Polygon" tool 

Note: For consistency and accuracy, it is recommended when digitizing, to remain a constant scale value. A 
suggested scale is 1:2000 m. 

iii. 	 For examples of the expected result of accurate on-screen digitizing, see below: Figures B 17 & B 
18; 

Figure B 17 Ortho-photo image before digitizing Figure B 18 Ortho-photo image after digitizing 

iv. 	 Once digitizing of all impermeable surfaces in the study area is complete, select “Theme” → “Stop 
Editing”. When prompted to “Save Edits?”, select “Yes”. 

5) 	 Calculating the Area of Impervious Surfaces in the Study Area 

To calculate the area of the newly digitized polygons you must first download an ArcView Arcscript. This will 
allow the ArcView program to manually calculate the area of all of the individual polygons. 
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To calculate the area the user will have to add an Arcscript, which was developed by Dr. Guoyun Zhou, Kyushu 
University, Fukuoka city, Japan, which is available from the Esri Arcscript download page 
(http://arcscripts.esri.com/). This script has been added to the CD as (area.ave located in the folder named 
"Scripts & Extensions").There is also a zipped version of the script in the folder. 

6) Loading Area calculate tool ArcScript in ArcView 

i. Go to the Project Window; 

ii. Click the Scripts icon. Double click New (to make a new scripts window) 
Note if this is Script 1 or another number. That will be the script name used below. (See Figure B 
19); 

Figure B 19 Make a new scripts window 

iii. 	 Click the pull-down menu “Scripts”, then “Load Text File”; 

iv. 	 Navigate to the cd-rom drive and select the area calculation arcscript, (area.ave) (the script that 
makes the area calculation operation). The script text then loads into the open window; 

v. 	 Click the check symbol button  to compile; 

vi. 	 Double click in the empty space to the right of the icons. (See Figure B 20). The Customize dialog 
form will then be displayed. (See Figure B 21). 

Figure B 20 Double click in the empty space to the right of the icons 
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Figure B 21 customize dialog form. 

vii. 	 In the Customize dialog, in the “Type” drop-down menu select “View”. In the “Category” drop-down 
menu select “Tools”; 

viii. 	 Click the Tool button in the center of the form (circled in red in Figure B 21); 

ix. 	  Move the new blank button all the way to the right; 

x. 	 In the text lines at bottom: Double click “Apply”, this will then bring up the “script manager” box. (See 
Figure B 22) 

Figure B 22 Script manager box 

xi. Scroll to and select “script 1” (or latest script number from step (ii), above). Click “Ok”; 

xii. Double click the “Click” option, scroll to and select “script 1”, click “Ok”; 

xiii. Double click the “Cursor” option, select a cursor style that you like; 

xiv. Double click the “Icon” option and select an icon that you like. Then close the customize dialog box. 
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The new area calculation icon has now been installed. 

7) Using the created new Arcscript function 

First highlight the theme that contains the digitized polygons and the road buffer. Then click the created button, 
next click anywhere on the layer in the view. This automatically adds a field in the attribute table of the theme 
with the area calculated. To collect the sum of the total area of the polygons, highlight the field header and then 
go to the pull-down menu “field” and select “statistics”. This will bring up a box with statistics; among the number 
is the sum of all polygon areas in the theme. 

To calculate the percentage of impermeable land from the study region, the newly calculated sum of the buffer 
and new polygons has to be divided by the total area of the region under study. Multiply the result by 100 and 
the resulting number will be the percentage of impervious land in the region. 

Note: If the area of the study area is not known, the area of the study region must be calculated, following the 
same steps as for the area calculation of the digitized polygons. (Do this by activating the study area polygon, 
and clicking on it with the area calculating tool, previously created.) 
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Appendix C Land Classification using PCI Geomatica and Erdas Imagine 
1) Required Data 

To begin the user will require the following files: 

•	 Geo-referenced Ortho-photos covering the selected region of study 

•	 GIS boundary file (polygon) for the region of study (sub-watershed) 

•	 Impervious surfaces to be classified include: 

•	 Houses, buildings, factories & all structures. 

•	 Pools, arenas, tennis courts. 

•	 Paved roads, driveways, parking lots. 

•	 Basically any other human-made objects that are permanent that does not allow water to penetrate into 
the ground. 

In order to complete this type of analysis, the capacity of a computer is significant.  This analysis was completed 
on a computer that had 240 GB disk space, 1 GB of memory, and 2.4 ghz processor.  The processes can be run 
on a computer of less capacity, however the length of time required to complete each process would increase. 

2) 	 Preparing the data for in Erdas 

In order to complete a land classification, the images files must first be mosaiced together and then clipped to 
the sub-watershed or boundary file.  These processes are completed in Erdas Imagine. 

(b) Mosaic in Erdas 

i. 	 From the main Erdas toolbar select Data Prep Tool 

ii. 	 In the Data Prep Tool, select Mosaic Images 

iii. 	 In the Editing drop down menu select Image List 

iv. 	 From here select Add Images, then you need to add your images to the list.  You may need to 
change the type of file extension, so your images are available to you.  Most often images are in 
SID, TIFF, GIF, or JPG formats. Erdas will accept any of these image formats, as well as several 
others. 

v. 	 Once you have added all of your image files to the list, click Add at the bottom of the window, then 
close. Your images should now be added to the Mosaic Tool file window.  They will not appear as 
actual pictures, rather just an outline, and will fit together in the correct Geo-referenced order. 

vi. 	 Now save this file, from the File drop down menu, select Save As, find the directory, and name the 
file. It will save it as a .mos file. 

vii. 	 From the Process drop down menu select Run Mosaic, define the new file name and select ok. 

viii. 	 This will begin the mosaic process, which depending on your computers capabilities and the size 
and resolution of your images can take up to several hours.  

(c) Clipping in Erdas 

i. 	 Back in the main Erdas toolbar, open a new Viewer; 

ii. 	 Open you new mosaic file, then the boundary file on top (which is a .shp file); 

iii. 	 Ensure that the boundary file is entire covered by the new mosaic images; 

iv. 	 Click on the boundary file, which should select it and highlight it in yellow; 

v. 	 From the Viewer select the AOI drop down menu, and Copy Selection to AOI; 
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vi. 	 Then from the File drop down menu go to Save, then Save AOI Layer AS, and name this file the 
boundary file name.  Then close this Viewer; 

vii. 	 Back in the main Erdas toolbar, open Data Prep; 

viii. 	 Select Subset Image; 

ix. 	 The Input File should be the mosaic image file, and define a new output file, which will consist of the 
images, cut to the boundary file; 

x. 	 At the bottom of the window, Select the AOI, select the AOI source as an AOI File, then open the 
AOI file you just created; 

xi. 	 This will begin the mosaic process, which depending on the computers capabilities and the size and 
resolution of the images can take up to several hours. 

The images are now ready to import into PCI for classification. 

3) 	 Preparing the images in PCI 

In order to use the image files created in Erdas, they must first be imported to a PCI format, then channels must 
be added the to images in order to complete the land classification. 

(d) Importing the image files 

i. 	 From the main PCI toolbar, open Focus (icon looks like a globe being opened); 

ii. 	 From the File drop down menu, select Utility, the Import; 

iii. 	 Select your Erdas image to be imported (this will be an .img file), then define your new output PCI 
file; 

iv. 	 In the Format Options, select Pixel Interleaved, and in the Pyramiding Options, select Disable 
Pyramiding; 

v. 	 Now click Import.  As noted before this process can be lengthy given the considerations discussed 
above. 

(e) Adding Channels 

i. 	 From the main PCI toolbar, open Xpace, (icon looks like a computer processor); 

ii. 	 From the Utilities drop down menu, select Locate Tasks, search for PCIMOD, once found, activate; 

iii. 	 In the File section, select the new PCI .pix file, in the PCIOP section enter ADD, and in the PCIVAL 
section type 2; 

iv. 	 Click status to ensure that everything is set up correctly, then click Run to proceed with the 

processing; 


v. 	 This will add 2 channels to your image file.  By adding these channels it will increase the file size, 
however they are necessary to write the training areas and the classified image. 

4) 	 Conducting the Land Classification 

The images are now ready to run a classification.  The time required to complete this process varies depending 
on how familiar users are with analyzing Ortho-photos, with enhanced knowledge, the images will be easier to 
read as to what types of coverages are occurring. 

(f) Running a Classification 

vi. 	 From the main PCI toolbar, open Focus, from the Tools drop down menu select Image 

Classification, and the Supervised; 


vii.	 Select your PCI .pix file to be classified; 
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viii. 	 In your Session Configuration, define a name for your classification, then select bands 1, 2 and 3 in 
the Input Channels column, then select one channel for your Training Sites, and the last channel for 
your Output Channel; 

ix. 	 In your Training Site Editing Window, in the Class Drop Down Menu, select New, to add a class, 
such as “covered surface” or “natural areas”.  Also select appropriate colours for each class, as 
these will be the colours used once the entire image is classified; 

x. 	 You will now be working between the Training Site Editing Window and the Project image window 
which contains your reference image.  On the Training Site window select the class you would like to 
work with (by clicking on it); 

xi. 	 In your reference image go to the View drop down menu, and then Zoom to, you must select 1:1 
resolution to select training sites.  Then you find areas representing the class you are working on 
and select them with the new polygons tool; 

xii. 	 You will do this for each class.  The key is to select very small and numerous samples for each 
class, ensuring that each sample is as homogenous as possible.  Remember to save often, which 
will retain your training sites in the file; 

xiii. 	 When you have completed collecting the training sites, then in the Training Site Editor under the 
Tools drop down menu, you can run a Classification Preview.  Use a Maximum Likelihood 
Classification with Null Class.  The null class is necessary, because of the no data areas 
surrounding the polygon (black areas); 

xiv. 	 The Classification Preview provides you with an opportunity to examine if your training sites are 
accurate enough or not.  This can be determined with a review of the reference image.  By means of 
selecting a site on the reference image and considering if it is classified properly in the classified 
image; 

xv. 	 The training sites may have to be refined several times, depending on the capabilities of the user; 

xvi. 	 Once the user is satisfied with the preview, the Classification can be run.  This is done by right 
clicking on the Classification MetaLayer in the reference image window.  Select Maximum Likelihood 
in the Algorithms sections and Null class in the Parameters section.  Also ensure that Show Report 
is selected.  Then select Classify; 

xvii. 	 This will produce the Classified Image, and the result will show in a new window; 

xviii. 	 Once the classification is complete, a report will be generated containing information as to the 
number of pixels for each class.  This is used to calculate the area percentage for each class, thus 
determining it’s coverage for the watershed. 

(g) Running and Accuracy Assessment on the Classified Image 

i. 	 From the main PCI toolbar, open Focus, from the Tools drop down menu select Image 

Classification, and Post Classification Analysis, and the Accuracy Assessment; 


ii. 	 Select your new classified image to assess. 

Operations section 

i. 	 In the Select Classified Image, select the channel that contains the classified image (this will likely 
be channel 5); 

ii. 	 In the Load Reference Image, select the channels that contain the original image (these will be 
channels 1,2,3, make sure to select them in this order); 

iii. 	 Click Generate Random Sample.  It will provide you with an option of how many points to select.  
This is recommended that 100 points per class be used, therefore for this study, it would be 200 
points; 

iv. 	 This will generate points across the reference image, then using the classes you have already 
created you will identify each point as the correct type of classification; 
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v. 	 Once you have completed all of the points, you can run the Accuracy Assessment from the Produce 
Accuracy Report.  You must click on each of the types of reports before they will be generated. PCI 
will compare each of the random sample points to the same point on the classified image and show 
if the classified image has classified correctly based on the classification you have given to the 
random point on the reference image; 

vi. 	 There are three types of report available, all of which detail the information in a different way; 

vii. 	 The Error Matrix will short list each class and the incorrect points which fell into that class, and from 
which class it was incorrectly listed; 

viii. 	 The Random Sample Report will provided the each random point, it’s geo-referencing as well as the 
pixel numbers, and the class assigned to it by the classification, and the accuracy assessment; 

ix. 	 The Accuracy Statistics provide the overall accuracy percentages and confidence interval, as well as 
the producers and users accuracy percentages for each of the classes. 
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